Meet the Expert Webinar:
Tips, Tricks, and Enhancements in the SAP IBP, add-In for Microsoft Excel version 2005.2.0

Product Management & Development, SAP
May 05, 2020

CUSTOMER
Disclaimer

The information in this presentation is confidential and proprietary to SAP and may not be disclosed without the permission of SAP. Except for your obligation to protect confidential information, this presentation is not subject to your license agreement or any other service or subscription agreement with SAP. SAP has no obligation to pursue any course of business outlined in this presentation or any related document, or to develop or release any functionality mentioned therein.

This presentation, or any related document and SAP’s strategy and possible future developments, products and or platforms directions and functionality are all subject to change and may be changed by SAP at any time for any reason without notice. The information in this presentation is not a commitment, promise or legal obligation to deliver any material, code or functionality. This presentation is provided without a warranty of any kind, either express or implied, including but not limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement. This presentation is for informational purposes and may not be incorporated into a contract. SAP assumes no responsibility for errors or omissions in this presentation, except if such damages were caused by SAP’s intentional or gross negligence.

All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
Agenda

1) Decoupling from SAP EPM-based add-ins
2) New Options Menu
3) Installation of IBP and EPM-based add-ins together on the same PC (Former side-by-side setup)
4) Installer: New advanced setup options
5) Changes for Silent Install / Uninstall Scripts
6) Support different Office Themes
7) Go Offline Mode
8) Support for Multi-Language
9) Context Menu: Show Cell Properties
10) Default Planning Horizon
Decoupling from SAP EPM-based add-ins to increase stability, maintainability, and performance and to open up new possibilities for future developments.
Decoupling from SAP EPM- based add-ins

Introduction

Being an add-on to SAP EPM (Enterprise Performance Management) acted like a kick-starter when introducing the SAP IBP Excel Add-In back in 2013. Without it, we would not have been able to deliver a Microsoft Excel based Planning UI for IBP in such a fast and stable manner. The working model in the past was very successful and the IBP teams benefitted tremendously from this concept. So why change it now?

1) IBP has grown, its customers have grown, the processes and needs have grown and we see more need to invest in features that are only needed by IBP, but would lead to technical dependencies or blockers with other SAP EPM-based add-ins.

2) Also when looking at performance, the large EPM layer serves mostly SAP Analysis for Office and BPC functions and could be slimmed down with a standalone IBP offering adding future performance improvement potential.

3) Many customers run IBP and other EPM-based add-ins in parallel and need to take the technical dependencies in account when upgrading one or the other solution, which can result in complex IT projects.

With release 2005, the IBP Excel add-in is no longer defined as an add-on to SAP EPM but is technically independent from SAP EPM. To gain independence, some fundamental changes had to be applied that will either provide immediate benefits to you or that are allowing us to tackle new feature developments in future that were up to now blocked due to dependencies.
Decoupling from SAP EPM-based add-ins

Benefits

Maintainability:
- Different way to run EPM and IBP Excel add-ins in a side-by-side scenario. You don’t need to use the side-by-side installers any longer.
- It is planned to stabilize the **minimum required EPM version** as much as possible in future so that an upgrade of the IBP Excel add-in does not require an upgrade of SAP EPM (and vice versa). Right now: SAP EPM 10.0 SP37 Patch 1

Usability:
- All EPM options and that were not compatible with IBP were removed. The ones that are compatible are summarized under a new “Options” window.
- We cleaned up the EPM Report Editor window and removed all settings that were not compatible with IBP.
- **All EPM functions that were not compatible with IBP were removed.** The ones that are compatible with IBP (e.g. EPMUser() ) continue to work as before. We have furthermore introduced these in the IBP namespace (e.g. IBPUser() ).

Performance Improvements:
- **Startup** of Microsoft Excel
- **Logon** to IBP
- **Open** Favorite / Template and **Refresh** of Planning Views
- **Formatting** (mainly due to disabled Microsoft Office Clipboard).
Basic Rule

All your templates and favorites will work as before.
Everything is migrated automatically and on the fly.

But...
Decoupling from SAP EPM-based add-ins
Backward Compatibility of Templates and Planning View Favorites

In order to completely cut any of the boundaries with SAP EPM, the structure and namespaces of the planning views on IBP side were changed. The IBP Excel add-ins from 2005 onwards are saving and updating the planning view templates and planning view favorites in this new format.

SAP IBP Excel add-ins that are older or equal to 2002.x.0 will not be able to open these planning view templates. The user will get an error message:

Please take this into consideration when upgrading to the 2005 version.

**Recommendation:** Upgrade all users to the new add-in version at once

*OR (in case that is not possible)*

When updating Templates, add them as a new template and place the older templates in a separate folder.

The administrators updating and adding templates or shared favorites will see a warning message on the UI:
Decoupling from SAP EPM-based add-ins

Automatic Migration of the EPM Formatting Sheets

Previously, the formatting sheets were called EPM Formatting Sheet and could be used and shared also across IBP and EPM planning views and reports. Starting with the IBP Excel add-in 2005, you will see that the existing EPM Formatting Sheets are automatically copied and migrated to IBP Formatting Sheets. All assignments to the sheets in the workbook are automatically replaced. The copy happens every time you open a planning view that still contains an EPM Formatting Sheet. Once you save the planning view (as a new or updated template or favorite), the IBP Formatting Sheet will stay and does not need to be migrated anymore.

All formatting sheet settings will stay consistent and should work as before. In case you are using EPM add-ins in a side-by-side set-up, those will continue to use the EPM Formatting Sheets and will ignore the IBP Formatting Sheets.

When you click on “View Formats” in the Edit Planning View group, only the IBPFormattingSheet will be unhidden. However, the EPMFormattingSheet is still there. You can unhide the tab manually.
Decoupling from SAP EPM-based add-ins
Automatic Migration of the EPM Formatting Sheets – Name

We are using the following naming conventions when migrating the formatting sheets:

If you used a formatting sheet name starting with EPM, then this will be renamed to IBP. E.g. from EPMFormattingSheet to IBPFormattingSheet.

If you used a completely different name, then the name is copied with standard Microsoft Excel means which adds an abbreviation (x). For example: MyFormattingSheet to MyFormattingSheet (2).

Please note that the header text in the migrated formatting sheet remains as before. So if it was named “EPM Formatting Sheet” before, this remains as we did not want to interfere with possible different naming's in your existing formatting sheets.
Decoupling from SAP EPM-based add-ins
Automatic Migration of the Custom VBA Code

Your current VBA code should work as before due to the SAP IBP – technical migration add-in (see list under COM add-in).

We however recommend to switch the following code line to get the IBP automation object to increase stability and performance in the mid-term:

Replace (there are 2 variants that could be implemented in your case):

- goEpmAuto = CreateObject("FPMXLClient.EPMAddInAutomation")
- goEpmAuto = Application.COMAddIns("FPMXLClient.Connect").Object

with new code line:

goIBPAuto = Application.COMAddIns("IBPXLClient.Connect").Object
Decoupling from SAP EPM-based add-ins
New technical migration add-in: “SAP IBP - Technical migration add-in (required)”

With the SAP IBP Excel add-in, you will find two COM add-ins related to IBP in your list.

The “SAP IBP, add-in for Microsoft Excel” entry represents the add-in itself.

The “SAP IBP - Technical migration add-in (required)” is the so-called forwarding add-in and makes sure your existing VBA code continue to work without any migration effort. Please make sure both are enabled at any time.
Decoupling from SAP EPM-based add-ins
EPM Functions that are compatible with IBP Excel add-in

In previous releases, you could already use EPM functions such as =EPMUser() to e.g. visualize the user name.

However, many EPM functions existed that did not work with IBP and hence did not return a result. The list was cleaned up now.

Functions that you used before in your planning view templates and favorites continue to work as usual. When adding new functions, you can now find three new categories on the Insert Function window of Microsoft Excel (click on \(\text{f}^2\) to open the window):

- IBP Functions
- IBP Functions (technical)
- IBP Functions (deprecated)
Decoupling from SAP EPM-based add-ins

**IBP Functions**

This category contains a list of all functions related to IBP that return a value or execute a certain function.

**IBP Functions (technical)**

The functions in this category are not intended to be used by an end user but are used automatically by the SAP IBP Excel add-in, e.g. when you create a planning view.

Microsoft Excel does not offer auto-completion for these formulas when entered in the formula field.

**IBP Functions (deprecated)**

Due to compatibility with older templates and favorites, the older EPM-named functions are still available in this category. However, we do not recommend using them for creation of new templates in future.
Decoupling from SAP EPM- based add-ins
EPM Name Manager entries that are compatible with IBP Excel add-in

In previous releases, you could already use entries from the Name Manager (on Microsoft Excel tab: Formulas), such as SOP_Planning_Area to visualize the Planning Area Name on the planning view.

The entries that are compatible with IBP remain here.
Decoupling from SAP EPM-based add-ins

EPM APIs that are compatible with IBP Excel add-in

SAP EPM had offered multiple APIs that could be used to call certain functions via VBA code. Only few of them were compatible with IBP (e.g. GetShift or DisplayFormattingSheets). We have removed all APIs that were not compatible.

Following APIs remain and can be used within the VBA Code:

<table>
<thead>
<tr>
<th>API Name</th>
<th>API Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SetSheetOption</td>
<td>Specify an option that applies to the specified Microsoft Excel sheet, or Microsoft Excel workbook</td>
</tr>
<tr>
<td>GetSheetOption</td>
<td>Return an option that applies to the specified Microsoft Excel sheet, or Microsoft Excel workbook</td>
</tr>
<tr>
<td>GetActiveConnection</td>
<td>Returns the active connection for the specified Microsoft Excel worksheet.</td>
</tr>
<tr>
<td>GetRowAxisDimensionCount</td>
<td>Returns the number of dimensions in the row axis of the specified report.</td>
</tr>
<tr>
<td>GetRowAxisMembers</td>
<td>Returns the list of the dimension members of the row axis for the specified report.</td>
</tr>
<tr>
<td>GetColumnAxisDimensionCount</td>
<td>Returns the number of dimensions in the column axis of the specified report.</td>
</tr>
<tr>
<td>GetColumnAxisMembers</td>
<td>Returns the list of the dimension members of the column axis for the specified report.</td>
</tr>
<tr>
<td>GetDataBottomRightCell</td>
<td>Returns the bottom-right Microsoft Excel cell of the data range of the specified report.</td>
</tr>
<tr>
<td>GetDataTopLeftCell</td>
<td>Returns the top-left Microsoft Excel cell of the data range of the specified report.</td>
</tr>
<tr>
<td>GetShift</td>
<td>Returns the shift value between the report data range and the row or column axis of the specified report.</td>
</tr>
<tr>
<td>EnableLocalMember</td>
<td>Enable or disable a local member in a specified report.</td>
</tr>
<tr>
<td>GetDimensionList</td>
<td>Returns the list of all dimensions for the specified connection.</td>
</tr>
<tr>
<td>DisplayFormattingSheets</td>
<td>Enables you to display the formatting sheet(s) in the current workbook.</td>
</tr>
</tbody>
</table>
Decoupling from SAP EPM-based add-ins
Worksheet Types

If your installation of the SAP IBP Excel add-in is set up for parallel usage of the SAP IBP Excel add-in with the EPM add-in, or with an Excel add-in that is based on the EPM add-in, the worksheet type is an essential attribute of a worksheet in your workbook. By defining different worksheet types on different sheets, you can switch between the functions of the EPM and the SAP IBP tab.

By default, the worksheet type of a worksheet that does not yet contain an IBP planning view or an EPM report is undefined. SAP IBP Excel add-ins identify an undefined worksheet type as IBP and EPM-based add-ins identify an undefined worksheet type as EPM. The worksheet type is set automatically to IBP when you either

- Create an IBP planning view on that sheet
- Change any of the IBP options (About → Settings → Options)
- Set the Worksheet type to IBP manually (About → Settings → Set as IBP Sheet)

Once it is set, the respective other EPM-based add-ins will recognize this and disable their functions on that sheet. The same is true when a worksheet type is set to EPM, then the IBP Excel add-in will recognize this and disable its functions on that sheet.

You can also set a worksheet to worksheet type “Excel Worksheet” using the Options under About → Settings → Options → General. This is recommended if the sheet should contain data that is not associated with IBP or EPM-based data and should not be recognized. For example this can be useful when the sheet contains data from other sources, when you want to create a pivot table on that sheet, or when you use the sheet as a hidden sheet to calculate and feed charts on your IBP planning views.
New Options Window
to improve usability
Decoupling from SAP EPM-based add-ins
EPM Sheet Options and Sheet Options merged and cleaned-up

Many of the EPM Sheet Options that could previously be found under “Advanced” in the Template Admin Group were not working with IBP and were listed on the IBP Release Restriction Note. That had let so some confusion in the past as to what can be used and what cannot.

We have now combined the EPM Sheet Options and the Sheet Options that you had previously seen under Edit Planning View → Sheet Options in one new window called “Options”, which can be found under “Settings”. This contains now all options that are working with IBP. All others were removed.

The EPM Sheet Options and the Sheet Options window are removed.

The sheet options in the General and Formatting Tab can now also be used without an active IBP planning view open.

You can adjust your settings there and then set these as default. The defaults are user dependent and are saved for the user on the PC.
New Options Window
Status 2002 and earlier

IBP Sheet Options
- Valid Planning View needed

EPM Sheet Options
- No valid Planning View needed

EPM Report Options
- Valid Planning View needed
New Options Window
2005 and later

Options

- Valid Planning View not needed for former Sheet Options (Set as Default), but still for Report Options
New Options Window
General Tab

The settings on this tab were taken over from the Sheet Options and the EPM Sheet Options window. The two windows were merged and only the settings that are compatible with IBP remain.

The tab contains some general settings for the planning view that the user can use e.g. to activate the local member recognition.

Almost all options are defined per sheet. The settings can be set as default, except for the “Clear data from the planning view when you save the workbook” which cannot be set as default.
New Options Window
Formatting Tab

The settings on this tab were taken over from the Sheet Options and the EPM Sheet Options window. The two windows were merged and only the settings that are compatible with IBP remain.

The settings have an impact on the formatting and appearance of the planning views. They are defined per sheet.

The settings can be set as default.
New Options Window
Protection Tab

This tab was taken over from the EPM Sheet Options window.

- It can be used to protect the active worksheet or workbook completely or certain features. The list of the lockable features was cleaned up and all features listed here are compatible with IBP.
- Initially, the protections tab is unlocked, and you can add a password and adjust the settings. This password can then later on be used to unlock the sheet or workbook again or change the settings.
- In case a sheet or workbook is locked you need to unlock the settings on the protections tab to change them. Click on the lock sign in the upper right corner and enter the password.
- To lock the sheet or workbook again (in case a password is already entered), click on OK.
- Although you unlock the protection tab settings by entering the password, the worksheet or workbook itself is only unprotected when you select “No Protection” and click on OK.
- Please note that you cannot access the Member Names tab if the workbook or sheet is protected. The tab is greyed out and a tooltip indicates why it is greyed out.
- In case you have protected the workbook, please note that you cannot open the formatting sheets without unprotecting the workbook beforehand.
- You cannot set the protection as default.
New Options Window
Member Names Tab (1)

This tab was taken over from the EPM Edit Report and redesigned to enhance usability.

- The member names can be used to display a different name on the Excel planning views than what is defined in the IBP backend.
- The names that you defined in previous versions are taken over.
- The new names can have a length of up to 100 characters.
- The member names can only be defined for the active sheet.
- You cannot set member names as default.
New Options Window
Member Names Tab (2)

- Dynamic Dimensions are not supported by the member names. If you have this enabled, you will only see the defined number of attributes that you had defined in the global configuration parameter MAX_DIM_MEMBERS. The names that are entered for these attributes are not saved and will be lost once the user closes the workbook.

The user is informed that he only sees a limited number of attributes:

- Renaming Local Members is not supported
- In case you are using flexible time axis on the sheet, please use the mixed time member to define the naming of the periods:
Decoupling from SAP EPM-based add-ins
EPM Report Editor Cleaned Up

Many of the EPM Report Editor settings that could previously be found under “Advanced” in the Template Admin Group were not working with IBP and were listed on the IBP Release Restriction Note. That had let some confusion in the past as to what can be used and what cannot.

The entry was renamed to Edit Report and the window only contains two tabs, one to change the layout and one to manage local members. Both tabs only contain the settings that are working with IBP.
The tab contains the settings for the layout of the planning view, so that you can consistently shift the view in different directions and also supports the known EPM sorting rules.

- All settings that were not compatible with IBP were removed.
- This window is only accessible if you have template administrator rights.
Decoupling from SAP EPM- based add-ins
Edit Report – Local Members Tab

The local members tab contains advanced capabilities to create, enable, manage and delete local members.

- All settings that were not compatible with IBP were removed.
- This window is only accessible if you have template administrator rights.
Installation of IBP and EPM-based add-ins together on the same PC (Former side-by-side setup)
Installation of IBP and EPM-based add-ins together on the same PC

In the past, the IBP Excel add-in and EPM-based add-ins were closely coupled and shared a lot of objects and code. This is changing with the IBP Excel add-in 2005.2.0, which is now running independently.

Therefore, you will not find the Side-by-Side installers any longer when downloading the IBP Excel add-in 2005 from the Service Marketplace.

In case you have been running the Side-by-Side set-up in the past and are running EPM or any of the SAP EPM-based add-ins (e.g. BPC) in parallel to IBP, you can now simply use any of the two available IBP Excel add-ins for 32-bit or 64-bit Microsoft Office versions.

However, please be aware that there is still a minimum EPM version that you need to upgrade to in order to run IBP and EPM in parallel without the side-by-side installers. Starting with SAP IBP Excel add-in 2005.2.0, this is **SAP EPM 10.0 SP 37 Patch 1**.
Installer setup with IBP and EPM-based add-in

- The sequence in which you install the IBP and EPM-based add-ins does not matter.

- In case you are running both EPM-based and IBP add-ins parallel, please be aware that deinstalling EPM-based add-ins (without reinstalling them again afterwards) might require a repair (see new repair mode for the installer) or re-installation of the IBP add-in. This is however only necessary if the user on the PC does not have authorization to write the registry keys.

- Installation setups where the IBP add-in is installed for all users, and the EPM-based add-ins are only installed for specific users on the same PC will not work for the users who don’t have the EPM-based add-ins installed.

- For further information, please refer to
  - https://launchpad.support.sap.com/#/notes/2558067
  - https://launchpad.support.sap.com/#/notes/2483569
Installation of IBP and EPM-based add-ins together on the same PC
New installation path and app data folder

The path where the IBP Excel add-in is installed by default has changed with 2005.

When installed for "All Users":
- Old: “C:\Program Files (x86)\SAP BusinessObjects\IBP Add-In”
- New with 2005: “C:\Program Files (x86)\SAP\IBP Excel Add-In”

When installed for the "Current User":
- Old: "C:\Users\USERNAME\AppData\Local\Programs\SAP BusinessObjects\IBP Add-In"
- New with 2005: "C:\Users\USERNAME\AppData\Local\Programs\SAP\IBP Excel Add-In"

The path where you can place e.g. default connection data has changed with 2005 (App Data Folder):
- Old: “%LOCALAPPDATA%\EPMOfficeClient”
- New with 2005: “%LOCALAPPDATA%\SAP_IBP_AddIn”
Worksheet Types

IBP and EPM are using separate worksheet types to determine if a sheet belongs to either of them.

This is specifically important in case you are using a mixed workbook approach where you have both IBP planning views and EPM reports in different sheets of the same Excel Workbook.

In case you have a blank sheet that never contained an EPM report or IBP planning view before, both add-ins consider it to be of their worksheet type. That is why you will see that both ribbons are active and working.

Once you create an IBP planning view, change an options setting, or set it as an IBP sheet manually (Settings → Set as IBP Sheet), the worksheet type is set as IBP and the buttons on the EPM ribbon are greyed out when you are working on that sheet. This works the other way round with the EPM add-ins. In case the worksheet type is set to EPM, the buttons on the IBP ribbon are greyed out.
Remarks regarding Mixed Workbooks with EPM and IBP

There are dependencies between IBP and EPM-based add-ins in case you are using a mixed workbook approach where you have both IBP planning views and EPM reports in different sheets of the same Excel Workbook.

- When you click on Go Offline, one the IBP sheets will be set to offline mode. So for mixed workbooks to make them fully offline, you need to click on “Go Offline” in the IBP ribbon and then again on “Offline Mode” in the EPM ribbon. Vice versa when you click Go Online again.

- The EPM workbook option “Refresh Data in the whole Workbook” is not supported in this set-up with mixed IBP and EPM worksheets in the same workbook and will lead to errors.

- In cases where you have an IBP and EPM sheet without any formatting sheets created yet, only the corresponding formatting sheet will be created. E.g. when you click on “View Formats” on the IBP tab, an IBP formatting sheet is created. When you click on “View Formats” on the EPM tab, an EPM formatting sheet is created.

- Even though some options are equal in IBP and EPM, they are decoupled from each other (e.g. Keep Formula on Data or Local Member Recognition). Setting one option to “Save as default” on one side does not default it on the other side.

- If you save a mixed workbook as an IBP template or favorite, all data from the IBP and EPM sheets is cleared before saving. When you open the IBP template or IBP favorite again, the data on the IBP sheets is automatically refreshed. On the EPM sheets, you will find an empty report. You need to click on refresh to load the EPM data.
Installer: New advanced setup options to improve stability and performance
When installing the IBP Excel add-in 2005 version, you will see a new advanced set-up menu with 2 additional options to choose from.

The first one lets you choose if you want to disable the Office Clipboard for Microsoft Office applications on that PC. Within this clipboard, users can usually find the history of their copy activities (e.g. when you copy text via CTRL + C).

By default, it is set to “Disabled”. If you wish to continue to use the Office Clipboard, you can uncheck this option and it will be continued to be enabled.

It is recommended to disable it due to performance considerations. Please find further information in this Microsoft Support Note: https://support.microsoft.com/en-us/help/2817672/macro-takes-longer-than-expected-to-execute-many-individual-copy-and-p and further documentation: https://support.office.com/en-us/article/copy-and-paste-using-the-office-clipboard-714a72af-1ad4-450f-8708-c2931e73ec8a

Please note that the clipboard can only be disabled during installation when no other Microsoft Office applications (e.g. Word, Power Point, Excel, Outlook) is open.

The Office Clipboard deactivation required changes to the registry keys. These can only be changed when all Microsoft Office are closed at the time of the installation of the SAP IBP Excel add-in. If any of the applications are running during installation, the Office Clipboard remains enabled.
IBP Excel add-in installer: Advanced Setup
Disable Office Clipboard - Troubleshooting

Please note that the Office Clipboard can only be disabled during installation when not currently used by any of the Microsoft Office applications (e.g. Word, Power Point, Excel, Outlook).

You can easily check if it was indeed disabled by opening an office application and then opening the Clipboard under the Home Tab.

The Clipboard still can appear even when disabled, however, if you copy some text you will see that it stays empty.

Significant impact when working with large planning views with many formatting rules and / or when several Microsoft Office products are used in parallel.

Please note that the normal Copy and Paste actions are still possible also with a disabled Microsoft Office Clipboard.
IBP Excel add-in installer: Advanced Setup

Startup Options / Launcher

The other advanced option is a new startup option, which can place the IBP Excel add-in as

- Windows Start Menu entry
- Shortcut on your Desktop

Both options are by default switched on as they come also with some recommended stability improvements.
Starting from 2005, users can pass a parameter so that the Desktop Shortcut and the Shortcut in Windows Program are not created when the Add-In is installed.

By default, the Desktop Shortcut and the Windows Program Shortcut are installed.

```
IBP_Add-in.exe /s
/v"/qn IBP_LAUNCHER_DESKTOP="False" IBP_LAUNCHER_STARTMENU="False"
```

IBP Excel add-in installer: Advanced Setup
Startup Options / Launcher
IBP Excel add-in installer: Advanced Setup
Startup Options / Launcher – Stability Improvements

When using these 2 options to start your IBP Excel add-in, a new Microsoft Excel instance will automatically open. Also, certain functions and settings are automatically checked and corrected so that the IBP Excel add-in is visible and working in the Microsoft Excel ribbon. This includes:

- The “SAP IBP, add-in for Microsoft Excel” as well as the “SAP IBP - Technical migration add-in (required)” are automatically enabled in the Microsoft Excel options.
- The “SAP IBP, add-in for Microsoft Excel” as well as the “SAP IBP - Technical migration add-in (required)” are automatically activated in the Microsoft Excel options.
- The load behavior is automatically set to auto-load in the Microsoft Excel Add-In Manager.
- Some repair mechanisms are run.

Steps 1-3 had to be performed manually in previous versions in case the IBP Excel add-in was not visible in the ribbon for various reasons. Also see SAP Note: 2476762 - IBP: Excel Add In not visible in the Excel Ribbon
Troubleshooting: The SAP IBP Excel add-in is still disabled, even though I used the IBP Launcher to start Microsoft Excel

There is still one known constellation in which the Launcher cannot enable the IBP add-in again in case it got disabled:

Set-up:
1) Admin installs the SAP IBP add-in for the end-users who have “standard” permission
2) Admin installs IBP for “All Users”. The IBP add-in is in this case added to the registry in branch “Local Machine” during installation.

Issue:
- Due to various reasons, the load behavior of the SAP IBP Excel add-in in the “Local Machine” branch is set to “0” instead of “3”.
- “0” means that the IBP Excel add-in is not automatically loaded when Microsoft Excel starts
- “Local Machine” has specific security standards and the SAP IBP Excel add-in launcher cannot change these values back to “3” again.

Solution:
- Try running the repair mode for the SAP IBP Excel add-in.
- The add-in can also be manually activated by the end-user in Microsoft Excel via the list of COM add-ins.
- Administrator could manually set the value back to “3” in the “Local Machine” branch.
You can use the installer to repair or remove the SAP IBP Excel add-in.

With the repair mode, certain constellations of missing or corrupted files, registry entries, and shortcuts can be repaired. It is recommended to use this option in case you are facing issues with the loading of the SAP IBP Excel add-in. These can occur for example when you have both the IBP Excel add-in and SAP EPM-based add-ins installed and are removing the SAP EPM add-in afterwards for good from that machine. In cases where the user does not have sufficient rights on that PC to write or update registry keys, a repair might be necessary.
IBP Excel add-in installer: Repair Mode
Via silent installation

Repair the installation of the IBP Excel Add-in using the Windows Command Prompt.

For SAP IBP Standalone x64 Bit version:
msiexec.exe /faum {787262EF-9D23-49DF-B8B1-E86F41B74973} /quiet

For SAP IBP Standalone x32 Bit version:
msiexec.exe /faum {1F0989EE-7D8E-453D-A2B4-FF4092570D65} /quiet
Miscellaneous Enhancements and Information

When installing the IBP Excel add-in, the installer is now automatically taking over the language settings of the user's PC. However, if the user had previously installed and SAP IBP Excel add-in version and had set a specific language using the User Settings, this setting will be used with priority.

When IBP will be upgraded from an older version, e.g. 2002.2.0, to 2005.2.0, this warning (see screenshot) will not appear. The installation process will start immediately.
Installer: Publisher has been verified Pop-Up

In case the SAP IBP Excel add-in is installed on the PC for the “Current User” only, a pop-up might appear when Microsoft Excel is first started. The user is asked to verify the installation of the “SAP IBP – Technical migration add-in (required)”. This add-in is an integral part of the SAP IBP Excel add-in starting with version 2005.2.0 and handles for example any VBA migration of older VBA code and functions that was created before the 2005 add-in.

- It is recommended to click on “Install”.
- If you click on “Don’t Install”, your current VBA coding might not work correctly on that PC.

This pop-up does not appear if the SAP IBP Excel add-in is installed for “All Users”.
Changes for Silent Install / Uninstall Scripts
Silent Uninstall of the IBP Excel add-in 2005
Changed Product Code

The product code of the SAP IBP Excel add-in changed with version 2005. The product code is used for example to silently uninstall the SAP IBP Excel add-in via the command line.

The new product codes are:

*For SAP IBP Standalone x64 Bit version (version 2005 or older):*
  * 787262EF-9D23-49DF-B8B1-E86F41B74973

*For SAP IBP Standalone x32 Bit version (version 2005 or older):*
  * 1F0989EE-7D8E-453D-A2B4-FF4092570D65

Also refer to SAP Note https://launchpad.support.sap.com/#/notes/2135948 for further information and commands around the changes for silent install and uninstall in the 2005 version.
Support different Office Themes to increase usability and accessibility
Support different Office Themes

The IBP Excel add-in windows* have now been reworked and are adjusting according to the office theme that the user has set (e.g. for Office 365 under File → Account).

Examples for User Settings:

White Theme:  
Colorful Theme:  
Dark Gray Theme:  
Black Theme:  

* Please note that there are few exceptions e.g. in the formatting sheet.
Go Offline Mode
to easily share your planning views with non-
SAP IBP Excel add-in users
Offline Mode for IBP Planning Views

With the new Offline Mode, you can now easily share your IBP Planning Views with users who do not have the IBP Excel add-in installed.

These users can open and work with the planning views (e.g. update key figure values) as a normal Excel Workbook file, send it back to you as an Excel Workbook and you can then set it to online mode again and upload their changes to the IBP backend system.

Sample Use Case:

1. IBP User creates Planning View
2. IBP User clicks on “Go Offline” and sends offline workbook to other user (e.g. supplier customer, co-worker) who does not have the IBP add-in installed
3. Non-IBP user opens workbook, makes changes to the data and sends it back (e.g. via Mail)
4. IBP user opens workbook, sets it online and saves the data changes
Offline Mode for IBP Planning Views
Convert IBP Formulas

By clicking on “Go Offline” in the “Data Input” group of the IBP ribbon, your current workbook including all sheets is converted to a Microsoft Excel Workbook that does not contain the IBP references and formulas any more so that it can be understood by Microsoft Excel installations that don’t have the IBP Excel add-in installed.

Example:

IBP formulas and references in an IBP planning view (online mode):

This online IBP formula can only be understood by Microsoft Excel installations that also have the IBP Excel add-in installed.

IBP formulas and references in a converted planning view (offline mode):

This offline formula can be understood by all Microsoft Excel installations, even without the IBP Excel add-in installed.
Offline Mode for IBP Planning Views

Sheet Protection

By clicking on “Go Offline” in the “Data Input” group of the IBP ribbon, your current workbook including all sheets is furthermore protected against changes that would destroy its structure and later on make it impossible to set it to “online mode” again and save the changes.

Only the data input area can be used in the offline mode. When the user clicks in any other area (highlighted in red in the screenshot), a warning comes up and his action is blocked. He cannot for example change the name of a key figure or an attribute value or remove rows from the sheet.

Please note that the formatting sheet is not protected against changes.
Demo
Offline Mode for IBP Planning Views
Go Online

After you have received the file back and want to upload any data changes to the IBP backend system, you can open the Excel Workbook, logon to IBP which automatically sets the workbook in online mode again.

If you are already logged on to IBP when opening the offline workbook, click on “Go Online” in the IBP ribbon.

Afterwards click on “Save Data” to upload the data changes.
Offline Mode for IBP Planning Views
Using the offline mode in mixed workbooks with IBP and EPM sheet types

Only sheets with worksheet type IBP will be set to offline mode when using the Go Offline feature on the IBP ribbon.

When you are using Microsoft Excel Workbooks that contain a mixture of sheets with sheet types IBP and EPM and want also the EPM sheets to get offline, you have to also click on “Offline Mode” on the EPM ribbon. Otherwise these sheets would stay online.

Same behavior applies when you want the workbook to go Online again.
New VBA Sample Planning View supporting the Offline Mode

The chart in the new Sample VBA planning view, that can SOON be downloaded via SAP Note https://launchpad.support.sap.com/#/notes/1790530 supports also the offline mode.
Support for Multi-Language
to support your global implementation

Prerequisite: IBP 2005 backend system.
Also compatible with older SAP IBP add-ins
Support for Multi-Language

With the IBP 2005 release, you can maintain the attributes and key figure names and descriptions in different languages within the Multilanguage Support app in the IBP WebUI.

These translations are then also reflected in the SAP IBP, add-in for Microsoft Excel 2005.2.0. The language that is taken into account is the language that the user has set in the user settings in the add-in ribbon. If no translation exists for that language set in Excel, the texts are shown in the default system language which can also be set in the Multilanguage Support app.

The translated texts appear for example in the following area:

- Edit Planning View incl tooltip
- Planning View
- Filters
- Master Data Workbook

In case language content is changed while a user is still logged on, the user will only see these changes after disconnecting and logging on again.
Support for Multi-Language

Some Remarks

- When defining rules via the Property Selection in the **IBP formatting sheet**, please make sure that you are aware that the "**Description**" properties are also **language dependent**. So the formatting rule would only be applied in the language in which you have initially defined the rule.

- **The selections for the chart are not updated in case you switch languages.** You need to remove and add them back in case it contains translated text with a different language.

- When using the Go Offline / Go Online functionality, you will see that the language in which the attributes and key figures are shown will only adapt after you click Go Online and Refresh in case you are using a different language than the one that was used when the workbook was set Offline.

- The language used in the SAML login windows during Logon is derived from the language settings set in the Internet Explorer. Hence it can differ from the other language settings of the user and the IBP system.
Tips and Tricks:
Usage of the Show Cell Properties in Context Menu to ease your life when defining formatting rules
Context Menu: Show Cell Properties

On a planning view, you will now see a new entry in the context menu, when doing a right-click on a cell containing an attribute value (e.g. MyBrand), a key figure (e.g. Delivered Quantity), or a time period (e.g. May 2020).

Depending on the object that you clicked on, additional information is shown that can be useful to better understand the object and which can also be used to easier identify the member properties to use in the formatting sheet.
Context Menu: Show Cell Properties
Example: Key Figure Information

The information shown in the context menu consists of all properties that are defined for that key figure:

- **Header of the window** equals the key figure name
- **CALC** is defined as Y (Yes) if the key figure is not editable. The property is set to N (No) if the key figure is editable or system editable as per the IBP configuration.
- **DESCR** equals the key figure description
- **Fixing Enabled** defines if the key figure is fixing enabled (Y (Yes)) or not (N (No))
- **Alert Key Figure** defines if the key figure is an alert key figure (Y (Yes)) or not (N (No))
- **Edit Offset** equals 0 (zero) in all cases.
- **Editable Indicator** equals the editability settings for that key figure in the IBP configuration, e.g. ALL / NONE / PAST / FUTURE
- **ID** equals the key figure ID

This information can then also be used to set up formatting rules via the Property Selection in the Formatting Sheet and make sure your rule is valid for your specific use case:
Context Menu: Show Cell Properties
Example: Attribute Value

The information shown in the context menu consists of all properties that are defined for that attribute value:

- **Header of the window** equals the attribute name
- **CALC** is mostly set to N (No) in case of key attributes. For other attributes is mostly set to (Empty). In special cases, the results can differ from this rule.
- **ID** equals the attribute ID

This information can then also be used to set up formatting rules via the Property Selection in the Formatting Sheet and make sure your rule is valid for your specific use case:
Context Menu: Show Cell Properties
Example: Time Period Information

The information shown in the context menu consists of all properties that are defined for that time period:

- **Header of the window** = Period description as defined in the time profile
- **CALC** = Y (Yes) / N (No) is defined as Y (Yes) in case the PCF indicator is set to P (Past). In all other cases it is set to N (No).
- **RELATIVE** defines the difference between the period and the current period as an integer value. E.g. if today is January 2020, then the relative is 2 for March 2020 and 0 for January 2020, and -1 for December 2019. Can also be 0001 or -0002 depending on your global configuration setting DISABLE_LEADZEROS_TIME_RELATIVES.
- **DISPLAYHORIZON** marks the lowest / from (-1) and highest / to (1) period as defined in the Horizons in the Past and Horizons in the Future values in your time profile that is assigned to your planning area. For all other periods, the value is Empty.
- **Past Current Future Indicator** = F (Future) / P (Past) / C (Current) / CF (Current and Future) / PCF (Past, Current and Future). Please refer to [SAP Note 2570654](https://launchpad.support.sap.com.sap) for more information.
- **Timestamp From**: YYYY-MM-DD HH:MM:SS as defined in the time profile for Period Start
- **Timestamp To**: YYYY-MM-DD HH:MM:SS as defined in the time profile for Period End
- **ID** equals the Period ID as defined in the time profile

This information can then also be used to set up formatting rules via the Property Selection in the Formatting Sheet and make sure your rule is valid for your specific use case:
Context Menu: Show Cell Properties
Example: Scenarios

The information shown in the context menu consists of all properties that are defined for that scenario:

- **Header of the window** = Scenario Name
- **CALC** is always set to N (No)
- **ID** equals the IBP internal scenario ID (unique identifier). For the baseline scenario, the value is _PLAN, for other scenarios, it is a alphanumeric string.

This information can then also be used to set up formatting rules via the Property Selection in the Formatting Sheet and make sure your rule is valid for your specific use case:
Context Menu: Show Cell Properties
Example: Versions

The information shown in the context menu consists of all properties that are defined for that version:

- **Header of the window** equals the Version Name
- **CALC** is always set to N (No)
- **ID** equals the IBP version ID as defined in the IBP configuration. For the baseline version, it is always _BASELINE_.

This information can then also be used to set up formatting rules via the Property Selection in the Formatting Sheet and make sure your rule is valid for your specific use case:
Tips and Tricks:
Default Planning Horizon
to improve usability
Planning Horizon - Range

The “Periods in the Past” and “Periods in the Future” settings in your Planning Area determine the range of periods that the user can select in the SAP IBP Excel add-in.
The “Horizon in the Past” and “Horizon in the Future” settings in your Time Profile determine the default Period that is preselected in the SAP IBP Excel add-in.

e.g. 0 = Current Period

Defaulted to Current Period
Wrap Up
Decoupling from SAP EPM-based add-ins

Short Summary

- The IBP Excel add-ins from 2005.2.0 onwards are able to open templates and planning views that were previously created. The dependent areas are automatically migrated every time the planning views are opened.
- Older IBP Excel add-ins (2002 or older) are not able to open templates and favorites that were added or updated with an IBP Excel add-in 2005 or later.
- We introduce the IBP Formatting Sheet which is automatically migrated from your existing EPM formatting sheets. With the 2005 release, both mostly look the same, but in future this provides the possibility to adapt the formatting sheet to the needs of the IBP solution without interfering with EPM.
- We automatically migrate your existing VBA code that is currently pointing to EPM with a link to IBP.
- New product code for the SAP IBP Excel add-in that is needed to run the command for silent installation and uninstallation.
- User defined functions (e.g. IBPUSER()). EPM User defined functions, (e.g. EPMUSER()), local members, etc are working as before.
- Introduced IBP New “Options” menu with settings formerly found in Sheet Options, EPM Sheet Options, Edit Report
- Advanced installer options
- …
## SAP IBP, add-in for Microsoft Excel 2005.2.0

<table>
<thead>
<tr>
<th>Feature</th>
<th>Link</th>
</tr>
</thead>
</table>
| Key SAP Notes and KBAs Updated             | [https://launchpad.support.sap.com/#/notes/2394311](https://launchpad.support.sap.com/#/notes/2394311)  
[https://launchpad.support.sap.com/#/notes/2135948](https://launchpad.support.sap.com/#/notes/2135948)   |
| End User Guide Updated                     | [https://launchpad.support.sap.com/#/notes/2740969](https://launchpad.support.sap.com/#/notes/2740969)   |
| Best Practice and Performance Guide Updated | [https://launchpad.support.sap.com/#/notes/2686746](https://launchpad.support.sap.com/#/notes/2686746)   |
| New Version of the VBA Sample Planning View (available soon!) | [https://launchpad.support.sap.com/#/notes/1790530](https://launchpad.support.sap.com/#/notes/1790530) |
Roadmap and Customer Influence

Roadmap for SAP IBP

The roadmap (updated quarterly) can be found here:


Customer Influence

In case you have ideas for improvements or new features, please add your request here or vote for existing requests.

https://influence.sap.com/ibp
More Tips and Tricks

Please also listen in to the other Meet the Expert Webinars around the SAP IBP add-in for Microsoft Excel:

13 June 2019  Product Webinar  Meet the Expert: SAP IBP Excel Tips and Tricks
PDF: https://d.dam.sap.com/a/EYX3yd1
Recording: https://dam.sap.com/a/a74SqHn

Recording: http://sapnaevent.adobeconnect.com/pi9ugqtaplqo/
Thank You!

Anna Linden

SAP SE
Product Management SAP IBP
Product Owner SAP IBP, add-in for Microsoft Excel

anna.linden@sap.com